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[image: ]   COUNT clinic for scheduling purposes that passes over to CP User. Patient must be checked in/out and encounter form must be completed. Note, however, that if you use Appointment Manager to check in the patient, you may have to wait up to thirty minutes before you can check-in the patient to CP. During the thirty-minute timeframe, the Patient Care Encounter (PCE) application establishes the visit date. (If you use the Scheduling application to capture workload, make sure that the clinic location is the same as the default location in the Hospital Location field.)

Auto Submit to VistA Imaging: Select if a procedure is processed by a bi-directional instrument and additional data does not need to be matched. The study is automatically submitted to VISTA Imaging. If this field is not selected, the study will be in the Ready to Complete status. Optional.

Require External Data: Select if you want this procedure to allow external attachments. For example, you might want to attach an independent report from a VA or non-VA health care facility. If you want to manually select external attachments, you must select this field.

Be sure the Allow Non-Instrument Attachments checkbox is selected in CP Manager > System Parameters. There is no default for this field.

External Attachment Directory: If you select Require External Data, enter the path where the data is located, or browse to locate a directory (3-150 characters). There is no default on this field. You can locate any directory on the LAN. This is the directory that CP User accesses to find attachments. This directory must be a network share directory that the VistA Imaging Background Processor can access.

1Processing Application: Set the Processing Application field to HEMODIALYSIS for Hemodialysis procedures. Any other CP procedures will default to the Default setting, so you do NOT need to set the field.

Allowable Instruments: Select each automated instrument that provides results for this procedure. You can select more than one instrument for a procedure. If you only want to use external attachments, do not select any instruments.

You can select both Allowable Instruments and Require External Data. For example, you can have a pathology report from an endoscopy and you can attach the report to the procedure.

2Processed Results: This field is a flag which indicates whether a final result, multiple results, or cumulative result is associated with this procedure. This field is not accessible using the CP Manager application. It must be edited using File Manager.



1 Patch MD*1.0*6 May 2008 Processing Application field added.
2 Patch MD*1.0*11 June 2009 Processed Results field added.
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1Note: If the site does not have a multiple result instrument, NO setup needs to be made. CP automatically defaults to using '0' for Final Result. If the site has a multiple result instrument, the site can select either '1'
for Multiple Results which allows creation of a new TIU note for each result sent back or a '2' for Cumulative Result which allows the multiple result device to continuously send results back to the same TIU note. If the site needs to enter the PROCESSED RESULT field, the user will have to use File Manager to edit the field in the CP DEFINITION File (#702.01).




[bookmark: _TOC_250015]Adding a Procedure

Before you add a procedure, you can check to see if an appropriated titled procedure already exists that meets your needs. To view the names of procedures, select Procedures and then the appropriate treating specialty folder. A list of procedures is displayed. See Figure 6-8.
[image: ]
Figure 6-8

[image: ]  - Identifies an active procedure [image: ]  - Identifies an inactive procedure




If you decide that you do need to add a procedure, follow these instructions:

1. Select File > New > Procedure.

2. Enter the name of the procedure that you want to add. It is recommended that you enter the name in uppercase with a minimum of 3 characters and a maximum of 30 characters.

3. Click OK. The Edit screen is displayed. Figure 6-9 is the edit screen for procedures. The Procedure Name that you just entered is displayed in the left side of the CP Manager window in the Unassigned folder.

4. Enter data for each field as applicable. Refer to Editing a Procedure, p. 6-12, for detailed field descriptions.

5. Click Save when you are done. After you complete the edits, if you entered the name in upper case, the procedure name that you just entered is displayed in title case.

6. Click OK. The new procedure appears in the list on the left side of the CP Manager window. Check that the procedure is placed in the correct treating specialty folder.

7. Click Print if you want to print a Procedure report. See Printing Reports, p. 2-4.
[image: ]
1Figure 6-9
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1The following is a screen capture of using File Manager to edit the PROCESSED RESULT field in the CP Definition file (#702.01).

 (
>D P^DI
VA FileMan 22.0
Select
 
OPTION:
 
1
ENTER OR EDIT FILE
 
ENTRIES
INPUT TO WHAT FILE: CP TRANSACTION// 702.01 CP DEFINITION
(310 entries)
EDIT WHICH FIELD: ALL// PROCESS
PROCESSED
 
RESULT
PROCESSING APPLICATION CHOOSE 1-2: 1 PROCESSED RESULT THEN EDIT
 
FIELD:
Select CP DEFINITION NAME: PUL
PULMONARY ARTERY
 
CATHETER
PULMONARY
 
ENDOSCOPY
PULMONARY FUNCTION
 
INTERPRET
PULMONARY FUNCTION
 
TEST
PULMONARY
 
PROCEDURES
Press <RETURN> to see more, '^' to exit this list,
 
OR CHOOSE
 
1-5:
 
5
PULMONARY
 
PROCEDURES
PROCESSED RESULT: ?
Enter the processed result. Choose from:
Final
 
Result
Multiple
 
Results
Cumulative Result PROCESSED
 
RESULT:
 
1
Multiple
 
Results
Select CP DEFINITION NAME:
)















1 Patch MD*1.0*11 June 2009 Editing the PROCESSED RESULT field of CP Definition file (#702.01).





[bookmark: _TOC_250014]Step 4 – Setting Up System Parameters
System parameters are system-wide and affect all procedures and instruments. You must select Clinical Procedure On-Line, and fill in the Imaging Network Share and the VistA Scratch HFS Directory fields for CP to work properly. You can edit the other parameters as required for your site.

Here is a list of the system parameters:
* Indicates fields that must be filled in for CP to work properly. Allow non-instrument attachments
Bypass CRC Checking
Clinical Procedures Home Page
*Clinical Procedures On-Line 1* CP/BGP Transfer Directory CRC Values
Days to keep instrument data Imaging File Types
Offline Message Version Compatibility
· VistA Scratch HFS Directory
























1 Patch MD*1.0*4 September 2006 Imaging Network Share directory name changed to CP/BGP Transfer Directory.




1. Click System Parameters, which is displayed under the Clinical Procedures folder. The System Parameters Edit window is displayed. See Figure 6-10.

2. Enter information in the necessary fields and in the optional fields as needed by your site.
[image: ]
1Figure 6-10

[bookmark: _TOC_250013]Allow non-instrument attachments

Select if you want to let users attach files from the network to studies. If selected, the +Files icon displays in the Study window in CP User and lets the user select attachments. Indicates if external attachments (documents) are allowed including when an instrument has not created data.
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Be sure to select Allow non-instrument attachments if you selected the Require External Data field in CP Manager for a specific procedure. If you do not select Allow non-instrument attachments, you will not be able to attach files to a procedure.

[bookmark: _TOC_250012]Bypass CRC Checking

Select if you want to bypass CRC (Cyclical Redundancy Check) during startup. When a CP application starts up, it can check with the server to be sure that the checksum of the application that is running is the same as the checksum of the application that was distributed. If the checksum values do not match, a message displays stating that the values do not match. Even if values don’t match, you can continue using CP.

The checksum value is associated with the version number of the software. You might want to bypass this check when your site is running CP in test mode. If you are running different versions of the application, then the checksum values will not match.

[bookmark: _TOC_250011]Clinical Procedures Home Page

Displays the Clinical Procedures home page and directs the browser to this page when accessed. This parameter is used by the client application in the Help menu when the user selects the option Clinical Procedures on the Web.

Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the parameter is predefined. Do not modify this parameter unless the site is performing local modifications to the client software.

[bookmark: _TOC_250010]Clinical Procedures On-Line

Must select if you want to use CP User and CP Gateway. If this parameter is not selected, a warning message is displayed. (If a message has been entered into the Offline Message parameter, that message is displayed when the user tries to access CP User.)

This parameter is only effective when the VistA system is functioning and it is useful if you want to restrict access to Clinical Procedures. For example, you can set this field to offline if you are loading a newer version of CP.

[bookmark: _TOC_250009]CP/BGP Transfer Directory

Enter the shared directory that is accessed by the Imaging Background Processor (BGP) and CP Gateway. Reports generated from text need to be placed in a location that can be accessed by the BGP. The Network share must not reside physically on the Imaging RAID. You can also use Browse to select the directory. Must be filled in for CP to work properly.




[bookmark: _TOC_250008]CRC Values

A site can check that a specific build of the application is running on the client. This level of checking is not mandatory and you can use the Bypass CRC Checking parameter if the site does not want this level of security.

If a site is running more than one version of the application or is testing a new patch, this field can contain multiple entries, (Figure 6-11). Each entry contains the name of the application with extension (no directory path) followed by a colon „:‟ and the executable version number „#.#.#.#‟. Each of these entries contains the CRC value for that particular version of the executable. You can also obtain CRC values for a version of an executable from the About menu or by selecting CP Manager > Tools > Calculate a File’s CRC Value.

Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the parameter is predefined. Do not modify this parameter unless the site is performing local modifications to the client software
[image: ]
1Figure 6-11




[bookmark: _TOC_250007]Calculating a File’s CRC Value

You can calculate a file ‟s CRC (Cyclical Redundancy Check) value to determine if the file is the exact same file as the one that was distributed. CRC values are recalculated every time an application is compiled.

1. Select Tools > Calculate a file’s CRC Value.
2. Select the file.
3. You can copy the CRC value and paste it into a text file for reference purposes.

[bookmark: _TOC_250006]Days to keep instrument data

Enter the number of days (0-365) to save data from auto-instruments, after the data has been associated with a Clinical Procedures study. If the data has not been associated with a study, the data is not purged from the temporary storage area. Enter 0 or leave the field empty if you want the data to be retained forever.

[bookmark: _GoBack]Note: CP Gateway purges data daily. This purge only deletes the raw data that comes from the instrument. CP Gateway keeps data for a specified number of days based on the entry in “Days to keep Instrument Data”. Data older than this is purged. The data in Item Value field (#.1) and Item Text field (#.2) of the Upload Item multiple in the CP Results file (#703.1) are purged.




[bookmark: _TOC_250005]Imaging File Types

Verifies that a file type submitted by an instrument or user is acceptable and can be sent to the VistA Imaging RAID. The Open a Study option in CP User uses this system parameter to determine if a file is an acceptable file type, (Figure 6-12).

Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the parameter is predefined. Do not modify this parameter unless the site is performing local modifications to the client software
[image: ]
1Figure 6-12




[bookmark: _TOC_250004]Offline Message

Enter a message that users see when they try to activate CP User and Clinical Procedures is offline. This message only displays when the Clinical Procedures On-line parameter is not checked. See Figure 6-13.
[image: ]
1Figure 6-13

[bookmark: _TOC_250003]Version Compatibility

Displays a list of client versions, identified by their executable name and windows file version, which are compatible with the currently running server version. More than one version of the software may be flagged as compatible for backward compatibility. See Figure 6-14.

To check the client version number:


1 Patch MD*1.0*4 September 2006 Imaging Network Share directory name changed to CP/BGP Transfer Directory.



1. Open Windows Explorer and locate the Clinical Procedures folder.
2. Right-click CPGateway.exe, or CPUser.exe., or CPManager.exe.
3. Select Properties, and then click the Version tab. The version number, such as 1.0.0.17, is displayed.
4. Go back to CP Manager. Double-click Clinical Procedures, and then click System Parameters.
5. In the Version Compatibility tab, select each version that is compatible with the current server version, (Figure 6-14).

Note: The MDPOST routine in the KIDS build sets this field during installation. The data in the parameter is predefined. Do not modify this parameter unless the site is performing local modifications to the client software
[image: ]
1Figure 6-14

If an executable version is not compatible, the following message is displayed when you try to use a Clinical Procedures application:




[image: ]
Figure 6-15

If the application is CP Manager, the user is allowed to continue. If the application is CP User, the user needs to contact IRM because the client needs to be upgraded to the current version.

[bookmark: _TOC_250002]VistA Scratch HFS Directory

Clinical Procedures uses the Host File Server (HFS) functionality in the VA Kernel to create reports. VistA broker processes require full read, write, and delete access to this directory. (Check with IRM about this directory.) If this directory is not filled in, CP tries to use the broker environment directory. Must be filled in for CP to work properly.



1Step 5 – Exported Kernel XPAR Parameters
[bookmark: _TOC_250001]Exported Kernel XPAR Parameters for Patch MD*1.0*14

There are four Kernel XAR Parameters exported with patch MD*1*14.
· MD CHECK-IN PROCEDURE LIST
· MD CLINIC QUICK LIST
· MD CLINICS WITH MULT PROC
· MD USE APPT WITH PROCEDURE

A new option called MD AUTO CHECK-IN SETUP was added to setup and implement procedures that will use auto study check-in. Once a procedure is set up to use the auto study check-in functionality in the MD CHECK-IN SETUP option, the software will check-in any existing order requests with the status of “PENDING,” “ACTIVE,” and “SCHEDULED” in the Consult Request Tracking package.

Note: If your site uses appointments, schedule them before you enter the procedures for auto check-in. If you do not, the patients associated with those appointments will need to be manually checked in.

This option collects the following information:

a. Use Appointment with procedure? (Yes/No) (Required) – The default is “NO”, if the site does not schedule procedures before the order is entered. Enter “YES” if the procedure appointment is scheduled before the order is entered and the ordering provider selects the appointment for the procedure during ordering in CPRS.
b. Procedure (Required)– Enter the CP Definition that will be using the auto study check-in functionality.
c. Schedule Appointment? (Required) - Enter 0 for None, 1 for Outpatient, 2 for Inpatient, or 3 for Both. This indicates that the site schedules appointments for inpatient, outpatients, both, or none.
d. Clinic (Optional) – Enter the hospital location(s) that will be used for scheduling the procedure.

Note: If no clinic is entered in the setup, CP will use the hospital location defined in the HOSPITAL LOCATION field of the CP Definition file (#702.01) as the location of the visit for the CP study check-in.

The following two pages contain a screen capture of the MD AUTO CHECK-IN SETUP option:

1 Patch MD*1.0*14 March 2008 Exported Kernel XPAR Parameters, option, and screen sample added.
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Select OPTION NAME:	MD AUTO CHECK-IN SETUP	Auto Study Check-In Setup Auto Study Check-In Setup
Use Appointment with procedure? NO// ?

Default should be 'N' as most sites do not schedule procedures
before the order is entered.	Select 'Y' if the procedure appointment is scheduled before the order is entered and the ordering provider selects the appointment for the procedure.
Enter either 'Y' or 'N'.
Use Appointment with procedure? NO// Procedure: ?
Enter a CP Definition for the procedure to have auto CP study check-in.

Answer with CP DEFINITION NAME
Do you want the entire CP DEFINITION List? N	(No)

Procedure: COLONOSCOPY Schedule Appointment?: ?

REQUIRED field for the procedure to have auto CP study check-in. Enter a "^" will exit completely.

Enter 0 if you do not schedule appointments.
1 if you only schedule appointments for outpatients.
2 if you only schedule appointments for inpatients.
3 if you schedule appointments for both 1 and 2. Select one of the following:
0 None
1 Outpatient
2 Inpatient
3 Both

Schedule Appointment?: Both Clinic: ?
Only required, if appointments are scheduled for the procedure. Enter the clinic used for scheduling the procedure.

Answer with HOSPITAL LOCATION NAME, or ABBREVIATION, or TEAM
Do you want the entire 112-Entry HOSPITAL LOCATION List? N	(No) Clinic: GI LAB	PIPER,ALPHA

Enter another clinic for the same procedure? NO// ?
Enter either 'Y' or 'N', if you want to assign more than one clinic. Enter another clinic for the same procedure? NO//YES
Clinic: TEST
1 TEST/PROSTHETICS	OBRIEN,FRANCES U
2 TEST1
3 TEST1234
4 TEST3232
CHOOSE 1-4: 2	TEST1
Enter another clinic for the same procedure? NO// Procedure: ?
Enter a CP Definition for the procedure to have auto CP study check-in.



 (
COLONOSCOPY
Answer with CP DEFINITION NAME
Do you want the entire CP DEFINITION
 
List?
 
N
(No)
Procedure: EKG, ROUTINE (12 LEADS)
Schedule
 
Appointment?:
 
0
None
Procedure:
>
)
1Exported Kernel XPAR Parameters for Patch MD*1.0*6 There are four Kernel XPAR Parameters exported with Patch MD*1.0*6. PARAMETER DEFINITION:
[image: ]   MD APPOINT END DATE  [image: ]  MD APPOINT START DATE
[image: ]   MD COMPL PROC DISPLAY DAYS [image: ]  MD DAYS TO RETAIN COM STUDY

The users can edit the parameters using the Edit Parameter Values option, [XPAR EDIT PARAMETER].

The following is a screen capture of the parameter usage:
 (
Select PARAMETER DEFINITION NAME: MD APPOINT
 
END
 
DATE
End Date for Encounter
 
Appointments
---- Setting MD APPOINT END DATE for System: 
REDACTED
 ----
Days: ?
Enter a number from 0 to 365. Days: ??
Enter a number from 0 to 365 for the number of days that will be used to add to today as the end date range of the Encounter Appointments. If no value is entered, the default value used
Edit Parameter Values
--- Edit Parameter Values ---
Select PARAMETER DEFINITION NAME: MD APPOINT
 
START
 
DATE
Start Date for Encounter Appointments
--- Setting MD APPOINT START DATE for System: 
REDACTED
 
---
Days: ?
Enter a number from 0 to 365. Days: ??
Enter a number from 0 to 365 for the number of days that will be used to subtract from today as the start date range of the
 
Encounter Appointments. If no value is entered, the default value
 
used
will be 200.
Days: 365
Edit Parameter Values
D ^XUP
Setting up programmer environment Terminal Type set to: C-VT100  You have 2983 new
 
messages.
Select OPTION NAME: XPAR EDIT PARAMETER
)

1 Patch MD*1.0*6 May 2008 Exported Kernel XPAR Parameters and screen sample added.
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 (
will be 0.
Days: 2
Select PARAMETER DEFINITION NAME: MD COMPL PROC
 
DISPLAY
 
DAYS
Completed Proc Display Days Setting MD COMPL PROC DISPLAY DAYS for System:
 
REDACTED
Days: ?
Enter the number of days from 1 to 365. Days: ??
The number of days the completed procedure requests will be displayed in the CP Check-in screen.
Days: 365
Select PARAMETER DEFINITION NAME: MD DAYS TO RETAIN
 
COM
 
STUDY
Days to Retain Completed Study
Setting MD DAYS TO RETAIN COM STUDY for System: 
REDACTED
Days: ?
Enter the number of days from 1 to 365. Days: ??
The number of days after check-in date/time to display the study that has been complete in the CPUser application. Studies that have procedures with multiple or cumulative results are NOT
 
included.
Cumulative and multiple results studies will have a default value of 365.
Days:
Select PARAMETER DEFINITION NAME:
)


1Exported Kernel XPAR Parameters for Patch MD*1.0*11
There are three XPAR Parameters exported with patch MD*1.0*11. They are the following:
· MD CLINIC ASSOCIATION
· MD OLYMPUS 7
· MD USE APPOINTMENT

Parameter MD CLINIC ASSOCIATION will be used by option MD AUTO CHECK-IN SETUP. The users can edit the MD OLYMPUS 7 and MD USE APPOINTMENT parameters using the Edit Parameter Values option,[XPAR EDIT PARAMETER].
 (
Edit Parameter Values
--- Edit Parameter Values ---
Select PARAMETER DEFINITION NAME: MD
 
USE
 
APPOINTMENT
Use Appointment Locatio n
---- Setting MD USE APPOINTMENT for System: 
REDACTED
 ----
Use Appointment location: ??
Edit Parameter Values
D ^XUP
Setting up programmer environment Terminal Type set to: C-VT100
Select OPTION NAME: XPAR EDIT PARAMETER
)

1 Patch MD*1.0*11 June 2009 Exported XPAR Parameters sample added.



 (
Set this value to Yes to allow CPUser to use the location of the appointment selected during CP study check-in for the workload. Otherwise, the hospital location of the CP Definition will be used. If no value is entered, the default value is No.
Use Appointment location:
Select PARAMETER
 
DEFINITION
 
NAME:
MD
 
OLYMPUS
 
7
MD OLYMPUS
 
7
------- Setting MD OLYMPUS 7 for System: 
REDACTED
 -------
Yes/No: ??
This parameter definition indicates whether the Olympus device is version 7.3.7. The value is Yes/No. The default value
is "No".
Yes/No:
)
 (
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[bookmark: _TOC_250000]7.	Scheduled Options

1Two options are added by patch MD*1*14.

NAME: MD SCHEDULED STUDIES	MENU TEXT: Scheduled Studies TYPE: run routine	CREATOR: REDACTED 
PACKAGE: CLINICAL PROCEDURES
DESCRIPTION:	This option is tasked to run daily.	It will process the HL7 messages that need to be sent to the device on a daily basis for CP studies.
ROUTINE: EN1^MDWORSR	SCHEDULING RECOMMENDED: YES UPPERCASE MENU TEXT: SCHEDULED STUDIES

NAME: MD STUDY CHECK-IN	MENU TEXT: Study Check-in TYPE: run routine	CREATOR: REDACTED 
PACKAGE: CLINICAL PROCEDURES
DESCRIPTION:	This option is tasked to run daily.	It checks-in CP studies for procedures that require multiple encounters such as Hemodialysis, Respiratory Therapy, and Sleep Studies.
ROUTINE: CLINICPT^MDWORSR	SCHEDULING RECOMMENDED: YES UPPERCASE MENU TEXT: STUDY CHECK-IN

The two options needs to be scheduled to run daily.
Schedule the option MD SCHEDULED STUDIES to start the next day after patch installation at 4am.	This task will process the studies that are associated with the appointments that are dated for that day.	If the procedure request is associated with a future appointment, the study that is auto checked-in will have a status of “New”.	The MD SCHEDULED STUDIES task will process the study and change the status to “Pending Instrument Data”.

Sample Screen capture of the scheduled option:

 (
QUEUED TO RUN AT WHAT TIME: MAY 22,2007@04:00 DEVICE FOR QUEUED JOB OUTPUT:
QUEUED TO RUN ON VOLUME SET: site volume RESCHEDULING FREQUENCY: 1D
TASK PARAMETERS:
SPECIAL QUEUEING: Startup Persistent
Edit Option Schedule Option Name: MD SCHEDULED STUDIES
Menu Text:
 
Scheduled
 
Studies
TASK ID:
 
2619819
(R)
Select OPTION to schedule or reschedule: MD
MD
 
SCHEDULED
 
STUDIES
Scheduled
 
Studies
MD
 
STUDY
 
CHECK-IN
Study Check-in
CHOOSE
 
1-2:
 
1
MD
 
SCHEDULED
 
STUDIES
Scheduled
 
Studies
)

1 Patch MD*1.0*14 March 2008 Add Scheduled Options.
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 (
COMMAND:
Press <PF1>H
 
for
 
help
Insert
)

Schedule the option MD STUDY CHECK-IN to start to run the next day after patch installation at 5am.	If a procedure request requires multiple encounters, this task will auto check-in the study for the multiple encounters using the appointment scheduled.	The RESCHEDULING FREQUENCY can be more than 1D (1 day), if your site schedule appointment for the day after 5am and the task will not be able to pick it up.
 (
Insert
Press <PF1>H for help
COMMAND:
Option Name: MD STUDY CHECK-IN
Menu Text:
 
Study
 
Check-in
TASK ID:
 
2620037
QUEUED TO RUN AT WHAT TIME: MAY 22,2007@05:00 DEVICE FOR QUEUED JOB OUTPUT:
QUEUED TO RUN ON VOLUME SET: site volume RESCHEDULING FREQUENCY: 1D
TASK PARAMETERS:
SPECIAL QUEUEING: Startup Persistent
Study Check-in
Select OPTION to schedule or reschedule: MD STUDY CHECK-IN
...OK?
 
Yes//
(Yes) 
(R)
Edit Option Schedule
)

1One option was added with patch MD*1.0*11 called MD PROCESS NOSHOW/CANCEL.

NAME: MD PROCESS NOSHOW/CANCEL
MENU TEXT: Process No Show/Cancel Studies
TYPE: run routine	CREATOR: REDACTED 
PACKAGE: CLINICAL PROCEDURES
DESCRIPTION:	This option is tasked to run daily.	It will check for any appointment that is No Show or Cancelled for CP studies in the "Pending Instrument Data" status.
ROUTINE: EN1^MDWCAN
UPPERCASE MENU TEXT: PROCESS NO SHOW/CANCEL STUDIES



1 Patch MD*1.0*11 June 2009 Add new scheduled option.
 (
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)
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This option should be scheduled to run once daily at the end of the day.		It is recommended that the option run at the end of the day at 4pm or 5pm.	You can increase the RESCHEDULING FREQUENCY to every hour (1H) or every 90 seconds (90S) to pick up no shows and cancellations of the same day.
 (
Insert
Press <PF1>H for help
COMMAND:
Option Name: MD PROCESS NOSHOW/CANCEL
Menu Text: Process No
 
Show/Cancel
 
Studies
TASK ID:
 
3331757
QUEUED TO RUN AT WHAT TIME: JUN 23,2008@16:00 DEVICE FOR QUEUED JOB OUTPUT:
QUEUED TO RUN ON VOLUME SET: Site volume RESCHEDULING FREQUENCY: 1D
TASK PARAMETERS:
SPECIAL QUEUEING: Startup Persistent
Process
Select OPTION to schedule or reschedule: MD PROCESS
 
NOSHOW/CANCEL No Show/Cancel Studies
...OK?
 
Yes//
(Yes) 
(R)
Edit Option Schedule
)



NOTE: It is recommended that all three tasks have the SPECIAL QUEUEING field be set as Startup Persistent so if the task is stopped unexpectedly, it will be re-started
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